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Preface

This Preface contains the following sections:

• Purpose

• Audience

• Organization

• Using this manual

• Typographical conventions

• Examples of syntax descriptions

• OpenEdge messages



Preface
Purpose

This book provides documentation for Database Administrators (DBAs) who plan to install 
OpenEdge® Replication. 

Audience

This book is intended for those who are familiar with OpenEdge® database administration, and 
who plan to install OpenEdge Replication on their system. 

Organization

Chapter 1, “Welcome to OpenEdge Replication”

Provides an overview of the OpenEdge Replication product, new features, and 
information about product support.

Chapter 2, “Before You Install OpenEdge Replication”

Documents the pre-installation tasks for OpenEdge Replication. 

Chapter 3, “Windows Installation”

Documents how to install OpenEdge Replication in Windows. The chapter provides 
information on setup prior to installation and gives step-by-step instructions to follow 
during the installation.

Chapter 4, “UNIX Installation”

Documents how to install OpenEdge Replication on UNIX. The chapter provides 
information on setup prior to installation and gives step-by-step instructions to follow 
during the installation. 
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Preface
Using this manual

OpenEdge provides a special purpose programming language for building business 
applications. In the documentation, the formal name for this language is ABL (Advanced 
Business Language). With few exceptions, all keywords of the language appear in all 
UPPERCASE, using a font that is appropriate to the context. All other alphabetic language content 
appears in mixed case.

References to ABL compiler and run-time features

ABL is both a compiled and interpreted language that executes in a run-time engine that the 
documentation refers to as the ABL Virtual Machine (AVM). When documentation refers to 
ABL source code compilation, it specifies ABL or the compiler as the actor that manages 
compile-time features of the language. When documentation refers to run-time behavior in an 
executing ABL program, it specifies the AVM as the actor that manages the specified run-time 
behavior in the program.

For example, these sentences refer to the ABL compiler’s allowance for parameter passing and 
the AVM’s possible response to that parameter passing at run time: “ABL allows you to pass a 
dynamic temp-table handle as a static temp-table parameter of a method. However, if at run time 
the passed dynamic temp-table schema does not match the schema of the static temp-table 
parameter, the AVM raises an error.” The following sentence refers to run-time actions that the 
AVM can perform using a particular ABL feature: “The ABL socket object handle allows the 
AVM to connect with other ABL and non-ABL sessions using TCP/IP sockets.”
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Preface
Typographical conventions

This manual uses the following typographical conventions:

Convention Description

Bold Bold typeface indicates commands or characters the user types, 
provides emphasis, or the names of user interface elements.

Italic Italic typeface indicates the title of a document, or signifies new 
terms.

SMALL, BOLD 
CAPITAL LETTERS 

Small, bold capital letters indicate OpenEdge key functions and 
generic keyboard keys; for example, GET and CTRL.

KEY1+KEY2 A plus sign between key names indicates a simultaneous key 
sequence: you press and hold down the first key while pressing the 
second key. For example, CTRL+X.

KEY1 KEY2 A space between key names indicates a sequential key sequence: 
you press and release the first key, then press another key. For 
example, ESCAPE H.

Syntax:

Fixed width A fixed-width font is used in syntax statements, code examples, 
system output, and filenames.

Fixed-width italics Fixed-width italics indicate variables in syntax statements.

Fixed-width bold Fixed-width bold indicates variables with special emphasis.

UPPERCASE 
fixed width

Uppercase words are ABL keywords. Although these are always 
shown in uppercase, you can type them in either uppercase or 
lowercase in a procedure.

This icon (three arrows) introduces a multi-step procedure.

This icon (one arrow) introduces a single-step procedure.

Period (.) 
or 
colon (:)

All statements except DO, FOR, FUNCTION, PROCEDURE, and REPEAT 
end with a period. DO, FOR, FUNCTION, PROCEDURE, and REPEAT 
statements can end with either a period or a colon.
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Preface
Examples of syntax descriptions

In this example, ACCUM is a keyword, and aggregate and expression are variables:

FOR is one of the statements that can end with either a period or a colon, as in this example:

In this example, STREAM stream, UNLESS-HIDDEN, and NO-ERROR are optional:

[ ] Large brackets indicate the items within them are optional.

[ ] Small brackets are part of the ABL.

{ } Large braces indicate the items within them are required. They are 
used to simplify complex syntax diagrams. 

{ } Small braces are part of the ABL. For example, a called external 
procedure must use braces when referencing arguments passed by 
a calling procedure.

| A vertical bar indicates a choice.

... Ellipses indicate repetition: you can choose one or more of the 
preceding items.

Convention Description

Syntax

ACCUM aggregate expression 

FOR EACH Customer:
DISPLAY Name.

END.

Syntax

DISPLAY [ STREAM stream ] [ UNLESS-HIDDEN ] [ NO-ERROR ]
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Preface
In this example, the outer (small) brackets are part of the language, and the inner (large) brackets 
denote an optional item:

A called external procedure must use braces when referencing compile-time arguments passed 
by a calling procedure, as shown in this example:

In this example, EACH, FIRST, and LAST are optional, but you can choose only one of them:

In this example, you must include two expressions, and optionally you can include more. 
Multiple expressions are separated by commas:

In this example, you must specify MESSAGE and at least one expression or SKIP [ (n) ], and 

any number of additional expression or SKIP [ ( n ) ] is allowed:

Syntax

INITIAL [ constant [ , constant ] ]

Syntax

{ &argument-name }

Syntax

PRESELECT [ EACH | FIRST | LAST ] record-phrase

Syntax

MAXIMUM ( expression , expression [ , expression ] ... )

Syntax

MESSAGE { expression | SKIP [ ( n ) ] } ...
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Preface
In this example, you must specify {include-file, then optionally any number of argument or 
&argument-name = "argument-value", and then terminate with }:

Long syntax descriptions split across lines

Some syntax descriptions are too long to fit on one line. When syntax descriptions are split 
across multiple lines, groups of optional and groups of required items are kept together in the 
required order.

In this example, WITH is followed by six optional items:

Complex syntax descriptions with both required and 
optional elements

Some syntax descriptions are too complex to distinguish required and optional elements by 
bracketing only the optional elements. For such syntax, the descriptions include both braces (for 
required elements) and brackets (for optional elements).

In this example, ASSIGN requires either one or more field entries or one record. Options 
available with field or record are grouped with braces and brackets:

Syntax

{ include-file 

[ argument | &argument-name = "argument-value" ] ... }

Syntax

WITH [ ACCUM max-length ] [ expression DOWN ] 
[ CENTERED ] [ n COLUMNS ] [ SIDE-LABELS ]
[ STREAM-IO ]

Syntax

ASSIGN { [ FRAME frame ] { field [ = expression ] }
[ WHEN expression ] } ...

| { record [ EXCEPT field ... ] }
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Preface
OpenEdge messages

OpenEdge displays several types of messages to inform you of routine and unusual occurrences:

• Execution messages inform you of errors encountered while OpenEdge is running a 
procedure; for example, if OpenEdge cannot find a record with a specified index field 
value.

• Compile messages inform you of errors found while OpenEdge is reading and analyzing 
a procedure before running it; for example, if a procedure references a table name that is 
not defined in the database.

• Startup messages inform you of unusual conditions detected while OpenEdge is getting 
ready to execute; for example, if you entered an invalid startup parameter.

After displaying a message, OpenEdge proceeds in one of several ways:

• Continues execution, subject to the error-processing actions that you specify or that are 
assumed as part of the procedure. This is the most common action taken after execution 
messages.

• Returns to the Procedure Editor, so you can correct an error in a procedure. This is the 
usual action taken after compiler messages.

• Halts processing of a procedure and returns immediately to the Procedure Editor. This 
does not happen often.

• Terminates the current session.

OpenEdge messages end with a message number in parentheses. In this example, the message 
number is 200:

If you encounter an error that terminates OpenEdge, note the message number before restarting.

** Unknown table name table. (200)
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Preface
Obtaining more information about OpenEdge messages

In Windows platforms, use OpenEdge online help to obtain more information about OpenEdge 
messages. Many OpenEdge tools include the following Help menu options to provide 
information about messages:

• Choose Help→ Recent Messages to display detailed descriptions of the most recent 
OpenEdge message and all other messages returned in the current session.

• Choose Help→ Messages and then type the message number to display a description of a 
specific OpenEdge message.

• In the Procedure Editor, press the HELP key or F1.

On UNIX platforms, use the OpenEdge pro command to start a single-user mode character 
OpenEdge client session and view a brief description of a message by providing its number.

To use the pro command to obtain a message description by message number:

1. Start the Procedure Editor:

2. Press F3 to access the menu bar, then choose Help→ Messages.

3. Type the message number and press ENTER. Details about that message number appear.

4. Press F4 to close the message, press F3 to access the Procedure Editor menu, and choose 
File→ Exit.

OpenEdge-install-dir/bin/pro
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Welcome to OpenEdge Replication

This chapter provides an overview of the OpenEdge® Replication product, new features, and 
information about product support, as described in the following sections:

• Overview of OpenEdge Replication

• New features

• What your OpenEdge Replication product includes

• Service and support: a 100% solution

• Registering your product

• Progress Software Developers Network



Welcome to OpenEdge Replication
Overview of OpenEdge Replication

Data replication has two major real-time functions: to distribute copies of information to one or 
more sites and to provide failure recovery to keep data constantly available to customers. 
OpenEdge® Replication automatically replicates a local OpenEdge® database to remote 
OpenEdge databases running on one or more machines. Once OpenEdge Replication is 
installed, configured, and started, replication happens automatically.

OpenEdge Replication offers users the ability to keep OpenEdge databases identical while also 
providing a hot standby in case a database fails. When a database fails, another becomes active. 
Therefore, mission-critical data is always available to your users.

Primary benefits of OpenEdge Replication

OpenEdge Replication provides the following benefits:

• Availability of mission-critical data 24 hours a day, seven days a week.

• Minimal or no disruption in the event of unplanned downtime or disaster.

Key features of OpenEdge Replication

OpenEdge Replication provides the following features:

• Automated real-time replication of databases for failover or disaster recovery.

• Single source database and multiple target database configurations.

• Data integrity between source and target databases.

• Continued source database activity while administration tasks are being performed.

• Reporting about replication activity.
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New features
New features

This section summarizes what is new with OpenEdge Replication:

• Progress® OpenEdge® Replication has been renamed OpenEdge® Replication. 

• OpenEdge Replication now supports the 64-bit data type (INT64) and the 64-bit dbkey.

What your OpenEdge Replication product includes

When you purchase OpenEdge Replication, you receive the following:

• The OpenEdge 10.1B product CD, which includes OpenEdge Replication and OpenEdge 
Replication Plus.

• The End-User Product License Agreement.

• The License Addendum, which includes the serial number and control numbers for your 
OpenEdge 10.1B, OpenEdge Replication, and, if applicable, OpenEdge Replication Plus 
installation. It also provides volume information and the media-ID number.

• The OpenEdge Replication User Guide in PDF format, available on the Documentation 
and Samples CD.

• The OpenEdge Replication Installation Guide (this manual), available in hard copy and 
also in PDF format on the Documentation and Samples CD.

• The OpenEdge Replication hardcopy release notes.

If any of the media or documentation are damaged or missing, call your supplier, or call 
Progress Software Corporation at (781) 280–4000. If you are outside of North America, call 
your regional sales office.
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Welcome to OpenEdge Replication
Accessing additional OpenEdge documentation on the 
Web

For your convenience, you can access the OpenEdge 10.1B product documentation from the 
Progress Software Developers Network (PSDN) Web site at:

Service and support: a 100% solution

Progress Software Corporation maintains a long-term commitment to superior product 
performance and productivity. Ultimately, product quality is a direct result of the judgment and 
experience of the people who work to produce it. The quality of an application development 
environment is only as good as the products and services that back it up. It is the people behind 
the product—in Development, Documentation, Technical Services, Education Services, and 
Consulting Services—who make the difference.

The Technical Support organization

The Technical Support organization is structured according to geographic regions, each with its 
own center. The regions are:

• Americas.

• Europe, Middle East, and Africa (EMEA).

• Asia Pacific.

Americas

The Americas Support Center is located in Bedford, Massachusetts. It provides telephone 
support in English, Spanish, and Portuguese for North American and Latin American 
customers. Hours of operation provide coverage that takes into account the business hours of 
local sales offices as well as time zone differences between countries in this region.

Customers can access the Americas Support Center by telephone, e-mail, or using the Progress 
Software Corporation Support Web site at http://www.progress.com/support.

http://www.psdn.com/library/kbcategory.jspa?categoryID=129
1–4
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Service and support: a 100% solution
Europe, Middle East, and Africa (EMEA)

The EMEA Technical Service Centre is located in Rotterdam, Netherlands, and supports our 
distributors, application partners (APs), and direct end users in the EMEA region. Support is 
offered in ten different languages, to supply telephone coverage in your native language. All the 
Technical Support Engineers (TSEs) belong to a language team to ensure telephone coverage. 
They also belong to one or more skill groups, defined around different areas of the Progress 
product set.

Customers can access the EMEA Support Centre by telephone, e-mail, or using the Progress 
Software Corporation Support Web site at http://www.progress.com/support.

Asia Pacific

The Asia Pacific Support Centre is located in Melbourne, Australia, and supports our 
subsidiaries, distributors, APs, and direct end users in the Asia Pacific region. Support is 
provided only in English.

Customers can access the Asia Pacific Support Centre by telephone, e-mail, or using the 
Progress Software Corporation Support Web site at http://www.progress.com/support.

Coverage offerings

Technical support is committed to providing the best possible customer support. For more 
detailed information and a complete reference to important names, phone numbers, and e-mail 
addresses, visit the Progress Software Corporation support Web site at 
http://www.progress.com/support.

Technical Support is available to you when the commercial products fail to work as 
documented. If it is determined during the course of a call that you would be better served by 
making use of training and consulting services, Technical Support might refer you to your local 
office.

Technical Support provides assistance with products according to our Product Life Cycle 
document. The following levels of customer support are available:

• Mission Critical Support — Focuses on your company needs and provides a designated 
Technical Account Manager (TAM), proactive personalized support, and direct access to 
senior level Technical Support Engineers.

• Extended 24x7 Support — Provides 24x7 support 365 days a year including holidays, 
one-hour guaranteed call back, and continuous effort for business-critical issues.
1–5
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Welcome to OpenEdge Replication
• Basic Support — Provides technical support during Progress Software Corporation’s 
standard business hours. For assistance outside of business hours, our online Knowledge 
Center is available 24x7 to provide you with solutions. 

• Partner After-Hours Support — Provides Application Partners the ability to offer their 
end users direct access to Progress Technical Support for after-hours support on Progress 
Software Corporation’s products. 

When you place your call

Some information is required when you log a support issue with Progress Software Corporation 
Technical Support. Here is a list of the primary information you need to provide when you place 
your support call:

• Your name.

• Your company name and/or customer number.

• The product’s serial number.

• The telephone number or e-mail address where you can be reached.

In addition, be prepared to answer the following questions to help us assist you more quickly:

• In which environment is the product running? Include:

– Memory.

– Swap space.

– Number of users.

– Disk space.

– Machine and model.

– Operating system and version.

– Progress product and version. 

– HLC or ESQL/C (Large or Small Client?).

– Multi-operating system environment (Yes or No?).

– Third-party products installed on the machine, and versions.
1–6



Service and support: a 100% solution
• Which error messages did you receive and where or when did you see them? Include:

– Messages appearing on screen from client or server or in log file (in the order they 
appeared).

– Previous messages in the log file (going back several days before onset of problem). 

– Message in hardware log or event viewer, if appropriate.

• What was happening when the problem occurred?

• Is the problem new, has it occurred before, or was it always there?

• How often does the problem occur? For instance, how many times has it occurred in the 
last twenty sessions?

• Can you re-create the problem at will or upon demand?

• Can you duplicate the problem against the Sports database?

• If you have more than one database, does the problem occur on all the databases?

• Does it happen with multi-user Progress, single-user Progress, or both?

• Was there anything unusual about the environment when the problem occurred?

• Do you have any idea what the problem might be? For example, are you aware of any 
recent changes in the system environment or in the application?

• Was a core file or Dr. Watson log file produced? If so, save this file in case the stack trace 
information is needed.

• What have you done so far to debug or isolate the problem? 

Placing your call to Technical Support

Before placing your call, please ensure you have all the relevant information available. You can 
contact your regional support center by telephone, fax, e-mail, or via the Web. See 
http://www.progress.com/support/tech_support/contact_support for the regional 
support numbers.
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Logging your calls on the Web

TechSupport Direct is available from the Support Web page at 
http://www.progress.com/support. Click the TechSupport Direct link. This is the direct 
Web interface into your regional Technical Support call logging and tracking system. Through 
this service, you can log, monitor, update, report on, and close your issues over the Web. A login 
ID and password are required.

Quick Log is a tool specifically designed for users to quickly log an issue without requiring a 
login ID or password. If you would like to update your existing call or check the status of a call, 
you must use TechSupport Direct.

From your customer site

If you call from a customer site, please make this known to the engineer. Ask that the priority 
of your call be set to HIGH to ensure you get a prompt call back if your issue cannot be resolved 
in the first call.

Supporting Progress Software Corporation customers

We support our customers. A customer is any organization that has a valid maintenance contract 
with Progress Software Corporation. Our goal is to provide the best support possible. To this 
end, it is important that we service and support those customers who have contracts with 
Progress Software Corporation.

In situations involving APs, the first call on any issue related to an end-user customer should 
come from the AP. It is important that the AP initiate all support calls to Progress Software 
Corporation. It is in the AP’s best interest to know what problems their customers are 
encountering and to isolate any problem. Furthermore, the customer of the AP is not the best 
resource in problem isolation between the AP’s application or software from Progress Software 
Corporation. The AP must stay involved with any problem that its customers might encounter 
with Progress software. This involvement will increase their knowledge and maintain the 
appropriate relationship with the customer. The AP also will be in a position to determine if this 
is a problem affecting a single site or the AP’s entire customer base.

If the customer of the AP contacts Progress Software Corporation directly, they will be asked 
to discuss their issue with their AP. Obviously, this does not replace the application support 
provided by the AP. Failure to renew your maintenance agreements for the licenses in question 
is likely to result in denial of support for any further calls.

If you have questions about evaluation licenses, future products or any sales-related questions, 
please contact your local presales support team at your local Progress Software Corporation 
office.
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Service packs

Service Packs are a collection of bug fixes to Progress Software Corporation products; they go 
through a high level of testing, including running a complete suite of regression tests. Service 
Packs are released for all supported platforms simultaneously, have the same version number, 
and contain the same fixes. Service Packs for Core Products are released every three months, as 
needed, from the product’s release delivery date. They are available online through the Product 
Updates and Documentation link on http://www.progress.com/esd. Service Packs include 
an installation procedure to take you through the steps to apply the service pack.

Registering your product

To be eligible for user support services, you must register your Progress Software Corporation 
product.

Benefits of the Annual Maintenance Plan

There are three important reasons for you to cover your Progress Software Corporation products 
under the Annual Maintenance Plan: access to new product versions, investment protection on 
product trade-ins, and access to Progress Software Corporation Technical Services.

Keeping up with software enhancements always is important, and often it is critical to the 
success of your application. Progress Software Corporation regularly introduces new features 
and capabilities. If you cover your products under the Annual Maintenance Plan, you can 
receive new versions for only a processing fee plus the cost of the documentation, where 
applicable. Also, if your product is covered under maintenance, there is no fee in most cases 
when you change an operating system, machine, or site (within the operations of a currently 
licensed customer).

Note: This does not apply to machine-based or unlimited user count licenses.

Finally, we think you will find access to our Technical Services staff invaluable.
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How do I enroll?

The Annual Maintenance Plan should be purchased when you purchase your Progress Software 
Corporation product and can be renewed at the end of that year. For the specific costs of your 
maintenance plan, please contact your supplier.

The sooner you enroll in the Annual Maintenance Plan, the more economical it is. If you enroll 
in the plan more than 90 days after purchasing your product, you are subject to substantially 
higher prices. Please contact your supplier if you have any questions about the Annual 
Maintenance Plan.

So don’t delay. Enroll in the Annual Maintenance Plan today!

If you purchased your product through a Progress Software Corporation Application Partner, 
contact them first to purchase maintenance.

Education Services

Progress Education Services offers a complete, task-based, hands-on curriculum for core 
Progress Software Corporation products. Both classroom training and non classroom 
alternatives are available.

Our classroom courses are taught by expert instructors in state-of-the-art facilities located 
around the globe. On-site training also is available, for the convenience of our customers who 
wish to take our courses directly at their workplace. For those who prefer learning at their own 
pace, we offer a full range of computer-based training, Web-based training, and text-based 
instruction courses.

By taking one of our courses, you receive education from professionals who have made 
software training a career focus. Our instructors are specialists who receive complete technical 
training in all aspects of our products. Our highly skilled course developers work together with 
top Progress software engineers to create the best possible training.

All our courses, whether classroom or self-paced, are task-based. That is, they emphasize what 
you need to know to do your job and how you can leverage the capabilities of Progress Software 
Corporation products to maximize your investment.

All our courses provide ample opportunity for practice through hands-on, real-world labs. In 
each course, you build an application that simulates a real-world environment. When you 
complete your training, you can take your newly built application with you for future 
development at your own site.
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A Progress Software Corporation education provides you with:

• The highest quality course materials for classroom and non classroom study, developed by 
expert course developers working closely with Progress software engineers.

• Experienced instructors with access to Progress Software Corporation benchmarking and 
source materials.

• Web-based and other computer-based training options that enable students to learn what 
they need, when they need it, without leaving the office.

How to remain current with Progress Software Corporation Education Services 
offerings

Progress Software Corporation offers you a wide and ever-increasing choice of educational 
options. We are continually offering new courses to address the pressing needs of our user 
community. For up-to-date information, visit us on the Web at 
http://www.progress.com/education/index.htm.

Progress Software Professional Services

Progress Software Professional Services (PSPS) offers strategic solutions to help you make the 
most of your technology investment and prepare you for the future. Whether you are looking to 
take your business to the Web, gain operational efficiencies through better reporting and 
decision support, or enhance your technology environment to make it run faster and smoother, 
Progress Software Professional Services can help you get there.

It is easier than ever to tap into the power of this expert knowledge and advanced insight with a 
collection of consulting, mentoring, and training programs tailored to address the issues you are 
facing right now:

• Business enhancement — Take your business to a new level by enhancing your existing 
Progress-based applications with valuable business solutions.

• Business migration and optimization — Master advanced strategies and tactics for 
moving your applications to the Web.

• System enhancement — Examine, tune, supplement, and manage your systems for 
maximum performance.
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• Globalization empowerment — Open your doors and start doing business with anyone 
in the world with speed and confidence.

• User training and education — Improve productivity by ensuring that everyone on your 
team is up-to-date on the latest Progress Software Corporation technology.

The inside advantage for consulting and education

Progress Software Professional Services is the only resource where you will find the kind of 
in-depth product knowledge and envelope-pushing attitude that lets you take your business to 
the next level of performance. We offer:

• More than 300 consultants worldwide.

• More than 60 product training experts.

• Expert project management teams and a dedicated Office of Project Management.

For more information

To find out how Progress Software Professional Services can help you with your most pressing 
objectives or to learn more about any of our programs, log on to 
http://www.progress.com/consulting/index.htm.

Services might vary from region to region. For information regarding Progress Software 
Professional Services in your area, contact the appropriate address listed below. For current 
information, visit our Web site at http://www.progress.com/worldwide/index.htm.

North America – Corporate Offices
14 Oak Park
Bedford, Massachusetts 01730
Tel: 781-280-4000
Fax: 781-280-4095

Latin America
Progress Software Corporation
2255 Glades Road
One Boca Place – Suite 300 E
Boca Raton, Florida 33431 USA
Tel: 561-998-2244
Fax: 561-998-1573

Europe/Middle East/Africa
Progress Software Europe BV
Schorpioenstraat 67
3067 GG Rotterdam
The Netherlands
Tel: 31 10 286 5700
Fax: 31 10 286 5225

Asia/Pacific
Progress Software Pty.
Level 2, 25 Ryde Road
Pymble NSW 2073, Australia
Tel: 61-2-9496-8439
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Worldwide sales offices and subsidiaries

Progress Software Corporation sells products and services worldwide to organizations that 
develop and use mission-critical business applications. With our partners, we deliver solutions, 
consulting, technical support, and training to customers in over 100 countries. Our Web sites 
around the world are updated to continually provide the most current localized content and 
area-specific information.

For a complete list of Worldwide Sales Offices and Subsidiaries, consult the Progress Software 
Corporation Web site at http://www.progress.com/worldwide/offices.htm.

Progress Software Corporation user groups

Progress Software Corporation user groups provide the ideal networking environment for you 
and other Progress users. Worldwide user groups provide a way to meet others in an informal 
setting to exchange ideas and discuss the applications that are impacting today’s fast-paced 
technology model. User groups feature Progress Software Corporation experts and other guest 
speakers, so you can keep up with the latest product advancements and trends. Progress 
Software Corporation actively supports its user groups with formal communication forums and 
discounts on training and other corporate events.

Whether you participate in person or via the Internet, a Progress Software user group is your 
best way to stay informed and stay connected.

For a complete list of Progress Users Groups, visit the Progress Software Corporation Web site 
at http://www.progress.com/support/user_groups.
1–13

http://www.progress.com/support/user_groups
http://www.progress.com/worldwide/offices.htm
http://www.progress.com/groups/listing.htm


Welcome to OpenEdge Replication
Progress Software Developers Network

Visit http://www.psdn.com. The Progress Software Developer’s Network (PSDN) is a service 
designed to deliver to developers the information and resources for creating best-of-breed 
business systems with Progress technology. At the PSDN, you will find technical reports, 
up-to-date product information, and a gateway for participating more actively in the Progress 
developer community. You also can subscribe to receive information on the topics and products 
most relevant to you.

If you have purchased maintenance on a development product directly from Progress Software 
Corporation, you are entitled to become a member of PSDN. Members receive two 
computer-based training courses prepared by Progress Education. In addition, members have 
deeper access to PSDN dynamic content that provides insight from product specialists into 
technological future directions and the opportunity to pose your technical questions directly to 
Progress experts during Web seminars and chats.

Premier PSDN membership is another level of service that includes subscriptions to the PSDN 
Software Developer’s Kit (SDK). The PSDN SDK is a comprehensive package of Progress 
Software Corporation products designed to support developing the full range of Progress 
applications: Web services-oriented, WebSpeed, distributed, client/server, and DataServer.

For more information about PSDN membership, please see http://www.psdn.com.
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2
Before You Install OpenEdge Replication

This chapter describes the system requirements you must consider and the tasks you must 
perform before you install OpenEdge Replication. The chapter also provides important details 
about platform support and licensing requirements, as described in the following sections:

• Planning your installation

• System requirements

• Licensing requirements



Before You Install OpenEdge Replication
Planning your installation

OpenEdge Replication provides database replication so that customers have access to their 
database with minimal interruption.

The way you plan the OpenEdge Replication installation depends on whether you are:

• Installing OpenEdge Replication for the first time.

• Upgrading an existing version of OpenEdge Replication.

Installing OpenEdge Replication for the first time

There are two primary requirements to consider before you install OpenEdge Replication for 
the first time: 

• You should have a comprehensive backup plan in place for your database before you begin 
the installation. 

• You need to decide where to install the OpenEdge Replication components.

Upgrading an earlier version of OpenEdge Replication 

If you are upgrading an earlier version of OpenEdge Replication, be sure to back up the 
following files:

• Source database.

• Target database.

• database.repl.recovery files. 

Because OpenEdge 10.1B upgrades the database.repl.recovery files, once you upgrade to 
OpenEdge 10.1B you cannot return to versions of OpenEdge Replication prior to Release 10.1B 
using your OpenEdge 10.1B files. If you need to return to a previous version of OpenEdge 
Replication on the source machine, you must back up your source database, start AI, and enable 
and configure OpenEdge Replication. 

On the target machine, you must make sure you set up your structure file, restore your backup 
from the source, and enable and configure OpenEdge Replication. Now you can run OpenEdge 
Replication by simply starting your source and target databases with an OpenEdge Replication 
qualifier.
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System requirements

The system requirements for OpenEdge Replication are essentially the same as those for 
OpenEdge 10.1B, as described in OpenEdge Getting Started: Installation and Configuration. 

Platform support

OpenEdge Replication is designed to run on the platforms supported by OpenEdge10.1B. 
OpenEdge Replication is not, however, supported on SCO Unixware.

Licensing requirements

OpenEdge Replication requires an OpenEdge 10.1B Enterprise Database or Workgroup 
Database license for each local or remote OpenEdge database used in replication. You can 
replicate only from Enterprise to Enterprise Database and Workgroup to Workgroup Database.
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3
Windows Installation

This chapter contains step-by-step instructions for installing OpenEdge Replication in 
Windows, as outlined in the following sections:

• Prerequisite applications

• Shutting down nonessential applications or tasks

• Resetting read-only files

• Installing OpenEdge Replication

• Uninstalling OpenEdge Replication



Windows Installation
Prerequisite applications

To run OpenEdge Replication, you must install either the OpenEdge 10.1B Enterprise database 
or Workgroup database. You can install either database at the same time that you install 
OpenEdge Replication, or before you install OpenEdge Replication. For more information 
about OpenEdge installations, see OpenEdge Getting Started: Installation and Configuration.

Shutting down nonessential applications or tasks

Shut down any nonessential applications or tasks that might be running. Also, shut down other 
applications or tasks that might interfere with the installation or use files that OpenEdge 
Replication needs to complete the installation. Shut down any processes where the executable 
itself, or a file used by the executable, is located in the directory where you intend to install 
OpenEdge Replication. Additionally, ensure that the AdminService is shut down.

Resetting read-only files

Before you install OpenEdge Replication in a Windows system, you should check the files in 
the location designated by the environment variables SytemDrive and SystemRoot to see 
whether any of the .dll files have the read-only bit set. If any .dll files in this directory are 
read-only, you must reset them to writable before installing OpenEdge Replication.
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Installing OpenEdge Replication

You are now ready to install OpenEdge Replication. Note that online Help assistance for 
OpenEdge is available as you proceed through the installation.

To install OpenEdge Replication in a Windows system:

1. See your License Addendum for additional information (including the serial number and 
control numbers) that you need to complete the installation. The Addendum also provides 
volume information and the media-ID number. Once you complete the installation 
process, keep the License Addendum in a secure area.

2. If you have not done so already, read the hard copy OpenEdge Replication Release Notes 
for the installation. The OpenEdge Replication Release Notes might replace or supplement 
the installation instructions in this book.

3. Close all other applications before beginning the installation process.

4. Insert the installation CD into your CD-ROM drive. If the CD does not run automatically, 
double-click setup.exe in the root directory of the CD. The Welcome dialog box appears:

The Welcome dialog box reminds you to close any other running Windows programs. 
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5. Click Next to continue. The Serial Number and Control Codes dialog box appears:

6. For OpenEdge Replication and each additional product you are installing, type the 
nine-digit serial number and each of the five-digit control numbers from your License 
Addendum.

Note: The serial and control numbers are not case-sensitive. The installation process 
automatically converts all letters to uppercase. The cursor advances to the next 
field automatically when you type the correct number of characters. 

When you click Accept, each product name is added to the Product(s) to be installed list.

7. Once you choose all the products you want to install, click Next to continue. The Product 
License Agreement dialog box appears.

8. Read the terms of the License Agreement carefully. To accept the agreement and proceed 
with the installation, click Yes.
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9. Click OK to acknowledge the copyright. The Choose Destination And Working Path 
Directories dialog box appears:

The Destination Directory identifies where OpenEdge Replication will be installed. The 
Working Directory contains your applications, your databases, and your log files.

The default Destination Directory is C:\Progress\OpenEdge, and the default Working 
Directory is C:\OpenEdge\WRK.

10. Accept the Choose Destination And Working Path Directories defaults, or click 
Browse to select alternate directories, keeping in mind the following important 
considerations:

• Do not make your OpenEdge working directory a subdirectory under the OpenEdge 
installation path. If you uninstall OpenEdge, the working directory is deleted along 
with the destination directory. Additionally, you cannot start a server for a database 
that has been installed in a subdirectory of OpenEdge.

• If you have other versions of OpenEdge products installed, do not enter the 
pathname where these products reside. In fact, if you specify the path of an existing 
OpenEdge installation, you are prompted to select another path, erase the current 
path, or install the products in the pre-existing path.

Be sure not to install the products in the pre-existing path if you do not want to 
overwrite any of your existing product directories and files.
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• If you want to add OpenEdge products to the most recently installed version, the 
install program assumes that you are adding products to that install location. For 
more information, see OpenEdge Getting Started: Installation and Configuration.

Caution: Never run OpenEdge products from the directory in which you installed them. 
If you do, you could damage the OpenEdge software files.

11.  Click Next to continue. The Setup Type dialog box appears:

12. Select Complete if you are installing only OpenEdge Replication, or if you intend to do a 
complete installation of all OpenEdge products.

OpenEdge Replication does not contain any selectable components, so you must do a 
complete installation. The steps that follow assume that you have chosen to do a complete 
installation.

If you are installing other products, however, it is possible to do a complete installation of 
OpenEdge Replication and custom installations of the other products. You can select 
Custom in the Setup Type dialog box and then select components and subcomponents for 
the other products. There will be no selectable components for OpenEdge Replication. For 
more information about complete and custom installations, see OpenEdge Getting 
Started: Installation and Configuration.
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13. Click Next to continue. The Configuring/Installing Components dialog box appears:

The options to configure the three recommended components are selected by default, 
unless you are installing OpenEdge Architect. In that case, the Progress Dynamics 
component option is not selected.

Clear the option for any component you do not want to configure.

14. Click Next to continue. The Select Program Folder dialog box appears:
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15. Click Next to continue. The Select Server Engine dialog box appears:

Note that the Install the SQL Server Engine option is selected by default. (To clear the 
option, click the check box.) For additional details about server engine options, click Help 
or see OpenEdge Getting Started: Installation and Configuration.

16. Click Next. 

Depending on which products (other than OpenEdge Replication) you are installing, you 
might see additional dialog boxes concerning the OpenEdge Adapter for Sonic ESB, 
WebSpeed, or Progress Dynamics®. For more information, see OpenEdge Getting 
Started: Installation and Configuration.
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If you are installing only OpenEdge Replication, the Language Choice dialog box 
appears:

The Language Choice dialog box contains two lists of languages. You can select multiple 
items from the Available Languages list. The Supplemental Language Set is displayed 
in a nonselectable list box. Click Available via Download to find information on where 
to get the untranslated languages.

Note: While the languages listed in the Supplemental Language Set are supported by 
OpenEdge, messages are not translated and appear in English only.

17. Select the languages you want to use for error and informational messages. OpenEdge can 
use these languages for run-time messages. The initial value for the default language is 
determined by the operating system on which you are installing OpenEdge. However, you 
can set the result to any of the provided languages.
3–9



Windows Installation
18. Click Next. The International Settings dialog box appears:

The International Settings dialog box allows the installation program to tailor your 
startup parameter file (startup.pf) to specify international conventions. (For more 
information on international conventions, see OpenEdge Development: Internationalizing 
Applications.)

19. From each drop-down list, select the international Character Set, Collation, and Case; 
Date Format; and Number Format to tailor the default startup.pf file. 

20. Click Next.

Depending on which products (other than OpenEdge Replication) you are installing, you 
might see the Web Services Adapter Settings at this point. For more information about 
Web Services adapter settings, see OpenEdge Getting Started: Installation and 
Configuration. 
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Otherwise, the AdminServer Authorization Options dialog box appears:

When you install OpenEdge in Windows operating systems, and you install OpenEdge 
products that use the AdminServer, the installation program prompts you to define 
optional security options. You can indicate whether individual and/or group authorization 
is required to start the AdminServer. 

The products that use the AdminServer are Progress® AppServer™, Progress® 
WebSpeed™, SonicMQ® Adapter, and the Progress Explorer. For more information 
about security options, see OpenEdge Getting Started: Installation and Configuration.
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21. Click Next. The Summary dialog box appears, displaying a summary of the installation 
options you selected:

22. Click Next. The setup program installs the OpenEdge files. When the installation finishes, 
the Complete Setup Done dialog box appears:
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23. Click Finish. 

Notes: If you are installing a product that contains Progress Dynamics® components, you 
must run the Dynamics Configuration Utility (DCU). The DCU installs and configures 
any specified Repository databases and other Progress Dynamics services required for 
your installation. 

Before you can start OpenEdge Replication, the AdminServer must be running.

For more information about installation and configuration of OpenEdge products, see 
OpenEdge Getting Started: Installation and Configuration.

Uninstalling OpenEdge Replication

When you manually delete files from the OpenEdge Replication directory tree, you only 
partially remove a OpenEdge Replication installation. By contrast, the Uninstall utility removes 
all OpenEdge Replication files as well as configuration information from the registry, which 
prevents conflict with subsequent OpenEdge Replication installations. If you want to upgrade 
or remove an installation, run the Uninstall utility from the OpenEdge program group.

Note that you cannot uninstall only OpenEdge Replication. If you want to remove OpenEdge 
Replication, you must uninstall the entire OpenEdge product.

You can run the Uninstall utility (or use the Add/Remove Programs utility located in the 
Windows Control Panel) to automatically remove OpenEdge from your system. Running the 
Uninstall or the Remove Program utility removes configuration information from the registry 
and prevents conflict with subsequent OpenEdge or OpenEdge Replication installations.

Caution: When uninstalling, do not delete any of the following Microsoft system files: 
mfc40.dll, mfc42.dll, mfcans32.dll, msvcrt.dll, msvcrt20.dll, msvcrt40.dll, 
olepro32.dll. These system files are common to other applications, and deleting 
them might adversely affect the operation of the other applications that use them. To 
avoid deleting these system files while running the Uninstall utility, answer NO to 
the prompts at the end of the uninstall process.
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To run the Uninstall utility:

1. Log in under the same domain and user name you used when you installed OpenEdge 
Replication.

2. Make sure that OpenEdge Replication is not running.

3. Make sure your Admin Service is not running.

4. Choose Start→ Programs→ OpenEdge→ Uninstall OpenEdge. A confirmation 
message appears:

5. Click Yes. The Remove Programs From Your Computer dialog box appears.

6. Click OK when the deletion is complete.
3–14



4
UNIX Installation

This chapter contains step-by-step instructions for installing OpenEdge Replication on UNIX 
platforms, as outlined in the following sections:

• Performing preinstallation tasks

• Installing OpenEdge Replication

• Uninstalling OpenEdge Replication
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Performing preinstallation tasks

Complete the following preinstallation tasks before starting your OpenEdge Replication 
product installation: 

• See your License Addendum for additional information that you need to complete the 
installation. The License Addendum includes the version number, serial number, and 
control numbers for your installation of OpenEdge Replication and any other products that 
you may be installing at the same time. It also provides volume information, the media ID 
number, and the licensed user limit. Once you complete the installation process, keep the 
License Addendum in a secure area.

• Read the release notes.

Your media box might contain a document entitled OpenEdge Replication Release Notes. 
If so, please read the hard copy release notes before performing the installation. The 
OpenEdge Replication Release Notes might replace or supplement the installation 
instructions in this guide. In addition, online OpenEdge Replication Release Notes are 
available during the installation.

• Install the OpenEdge 10.1B Enterprise Database or Workgroup Database.

JRE and JDK requirements

For details about JRE or JDK requirements, see OpenEdge Getting Started: Installation and 
Configuration.
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Installing OpenEdge Replication

You are now ready to install OpenEdge Replication. Note that as you proceed through the 
installation, OpenEdge online Help assistance is available.

To install OpenEdge Replication on each machine where it will run:

1. Log in as root. If you do not know the root password for your machine, check with your 
system administrator.

2. Insert the OpenEdge Replication installation CD into the CD-ROM drive. 

Note: There is an automount daemon on the Solaris platform that mounts the CD within 
approximately five seconds. If, however, the automount does not occur on your 
Solaris machine, use the mount command provided in Table 4–1. 

3. Enter your platform-specific mount command (where device-name is the device you are 
using for the installation and mount-point is the mount-point directory).

Note: You cannot install on Linux over an NFS-mounted device.

Table 4–1 lists the mount commands for each supported platform. 

Table 4–1: Mount commands (1 of 2)

Operating 
system Mount command

HP Tru64 UNIX mount -t cdfs -o noversion device-name mount-point
For example:
mount -t cdfs -o noversion /dev/rz3c /cdrom

HP-UX 11, 11i mount -F cdfs -r -o cdcase device-name mount-point
For example:
mount -F cdfs -r -o cdcase /dev/dsk/c0t2d0 /cdrom

IBM AIX 5L mount -v cdrfs -r device-name mount-point
For example:
mount -v cdrfs -r /dev/cd0 /cdrom
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4. Enter the following install command:

Note: You cannot run proinst if you are in the mount-point directory.

If you have either the supported JVM version on your system or a platform for which 
Progress Software Corporation ships a JVM, the Welcome dialog box appears:

HP-UX 
(PA-RISC) 
(32- bit, 64-bit)

mount –F cdfs –r –o cdcase device-name mount-point
For example: 
mount -F cdfs -r -o cdcase/dev/dsk/c1t2d0 /cdrom

HP-UX Itanium 
(64-bit)

mount –F cdfs –r –o cdcase device-name mount-point
For example:
mount -F cdfs -r -o cdcase/dev/dsk/c0t0d0 /cdrom

Linux mount -t iso9660 device-name mount-point
For example:
mount -t iso9660 /dev/cdrom /cdrom

SUN Solaris 
64-bit

mount -F hsfs -o ro,nrr -r device-name mount-point
For example:
mount -F hsfs -o ro,nrr -r /dev/dsk/c0t4d0s0 /cdrom

Sun Solaris 
SPARC

mount -F hsfs -o ro,nrr -r device-name mount-point
For example:
mount -F hsfs -o ro,nrr -r /dev/dsk/c0t4d0s0 /cdrom

Table 4–1: Mount commands (2 of 2)

Operating 
system Mount command

mount-point/proinst
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5. Press RETURN. The Product Configuration Data dialog box appears:

Table 4–2 describes the options available in the Product Configuration Data dialog box.

Table 4–2: Product Configuration Data dialog box options 

Option Function

ENTER = Additional Confirms that the product information entered is correct and 
clears the input fields for additional information for another 
OpenEdge product you want to install. 

CTRL+E = Done Confirms that the product information entered is correct and 
continues to the next step in the installation. The actual key you 
use to indicate Done varies by terminal type. Refer to the 
Product Configuration Data dialog box for the appropriate 
key combination for your terminal. 

CTRL+T = Quit Quits the Installation Utility. The Quit Confirmation dialog 
box appears. Type Y to quit or N to continue the installation.

Note: When you quit the installation process, the installation 
utility and all the installation files you copied into your working 
directory are deleted.

CTRL+N = Release 
Notes

Displays the online Release Notes.

CTRL+V = View Displays the products for which you entered control numbers. 

TAB = Next Field Moves to the next field in the dialog box.

CTRL+P = Help Provides Product Configuration Data dialog box help.
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6. Type your company name (any character string is acceptable), the serial number, and 
control numbers from your License Addendum for the first product you want to install. Use 
the TAB key to move to the next field.

Note: This information is not case-sensitive. The installation process automatically 
converts all letters to uppercase.

If you enter incorrect product configuration information, the following Error message 
appears indicating that the data is invalid:

Press RETURN to correct the product information and continue with the installation. The 
Product Configuration Data dialog box reappears, allowing you to enter the serial 
number and control numbers for the next product to install.

7. When you finish entering the serial number and control numbers for all the products you 
want to install, press CTRL+E. The Done Configuration Data Confirmation dialog box 
appears:
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8. Type Y to continue with the installation. The Install Type and Destination dialog box 
appears:

Table 4–3 describes the menu options on the Install Type and Destination dialog box 
that you will be working with once you choose the type of installation you want to 
perform. 

To select an option, highlight the option using the SPACEBAR key, the TAB key, the 
CURSOR keys, or the accelerator keys that are highlighted in each selection. Press ENTER 
to execute the selected option.

Table 4–3: Install Type and Destination dialog box options (1 of 2)

Option Function

Select type of Installation Allows you to select the type of installation you want 
to perform.

Select Destination Pathname Allows you to change the default destination 
pathname (/usr/dlc) and work directory (/usr/wrk) 
pathname.

Continue with Installation Confirms your selections (or accepts the defaults 
listed in the status box) and continues with the 
installation.
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You should read the online OpenEdge Replication Release Notes before continuing with 
the installation. These notes might replace or supplement the installation instructions in 
this guide. The notes appear in the vi or emacs editor when you choose View Release 
Notes.

9. Choose Select Type of Installation if you are doing a custom installation of products 
other than OpenEdge Replication. The Select Type of Installation dialog box appears:

OpenEdge Replication does not contain any selectable components, so you must do a 
complete installation. For more information about complete or custom installations, see 
OpenEdge Getting Started: Installation and Configuration.

Select the installation type, and press RETURN.

View Release Notes Allows you to view the latest release notes using the 
vi or emacs editor.

When you choose this option, the Installation Utility 
launches the editor. To exit vi after reading the 
Release Notes, type :q!. To exit emacs, press CTRL+X 
and then CTRL+C.

Cancel Cancels the previous selection.

Quit Installation Quits the Installation Utility. The Quit 
Confirmation dialog box appears. Type Y to quit or 
N to continue the installation. 

Note: When you quit the installation process, the 
installation utility and all the installation files you 
copied into your working directory are deleted.

Help Provides Install Type and Destination dialog box 
help.

Table 4–3: Install Type and Destination dialog box options (2 of 2)

Option Function
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10. Choose Select Destination Pathname and press RETURN. The following dialog box 
appears:

Note: The actual key you use to accept the default varies by terminal type. The Select 
Destination Pathname dialog box shows the appropriate key combination for 
your terminal.

11. Type your OpenEdge Replication destination path or accept the default directory 
(/usr/dlc). Then type the work directory path or accept the default provided (/usr/wrk). 

Caution: Do not make your working directory a subdirectory under the destination path.

12. Press RETURN. If the directory already exists, the Destination Pathname Exists dialog 
box appears:
4–9



UNIX Installation
Table 4–4 lists the options in the Destination Pathname Exists dialog box.

13. Choose one of the options and make the necessary changes. 

14. From the Install Type and Destination dialog box, choose Continue with Installation. 
Then press RETURN. The Select Server Engine dialog box appears:

Note that the SQL option is selected by default. (To clear the option, highlight it and press 
RETURN.) For additional details about server engine options, click Help or see OpenEdge 
Getting Started: Installation and Configuration.

Choose Continue with Install. Then press RETURN.

Table 4–4: Destination Pathname Exists dialog box options 

Option Action

Select an alternate destination path Allows you to select another destination 
path. This returns you to the Select 
Destination Pathname dialog box.

Erase the current destination path Deletes the contents and subdirectories 
of the named directory and reinstalls in 
the same directory.

Install the OpenEdge products in the 
pre-existing destination path

Installs OpenEdge products in the 
named directory. If the name of a file 
being installed matches the name of an 
existing file, the installation utility 
overwrites the existing file. The 
installation utility does not, however, 
overwrite the progress.cfg file.

Help Provides Destination Pathname Exists 
dialog box help.
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If you are installing the Sonic ESB product, you see a dialog box related to entering Sonic 
ESB properties. If you are installing any products with WebSpeed components, the 
installation program will ask for information about your Web server at this point. For more 
information, see OpenEdge Getting Started: Installation and Configuration.

15. If you are installing OpenEdge Replication alone, or with additional products that do not 
have WebSpeed components, the Language Selection dialog box appears:

16. Select the language you want to use for error and informational messages. To select a 
language, use your arrow keys to highlight the language and press RETURN. An asterisk 
(*) appears next to the selected language. 

17. Press M to choose a language as the default language. The symbol (d) appears to the right 
side of the default language. If you do not select a default language, a warning message 
appears. 

18. When you finish selecting the languages, choose Continue with Installation. The 
International Settings dialog box appears: 
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The International Settings dialog box allows you to tailor the default startup parameter 
file (startup.pf) to select international conventions for your locale, such as Character 
Set, Collation, Case, Date Format, and Number Format preferences. For more 
information on international conventions, see OpenEdge Development: Internationalizing 
Applications.

19. From each drop-down list, select the international Character Set, Collation, and Case; 
Date Format; and Number Format to tailor the default startup.pf file. 

20. Choose Continue with Installation. (If you have not completed a required international 
setting, a warning appears. You must go back and complete all required settings; then, 
continue with the installation.)

21. Press RETURN.

Note: If you are installing any products that contain Web services, the installation 
program will ask for information about your Web Services Adapter at this point. 
For more information, see OpenEdge Getting Started: Installation and 
Configuration.

The installation performs a check of available disk space. Provided your destination path 
choice has enough disk space, the Complete Installation dialog box appears, displaying 
a summary of the installation options you selected:
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22. Type Y to continue. The Copy Scripts dialog box appears:

OpenEdge Replication consists of several scripts and program modules. When you install 
the product, the scripts are placed in the installation directory you specify. 

23. Choose one of the following:

• To allow all users on your system to run the product, you could answer Yes when 
prompted to copy the scripts to /usr/bin. Type Y to instruct the Installation utility 
to place OpenEdge Replication scripts in /usr/bin and the destination pathname 
you specified earlier.

Caution: Answering Y might cause the OpenEdge Replication install to overwrite 
existing scripts in this directory.

• Type N to instruct the Installation utility to place scripts only in the destination 
pathname you specified earlier.

Note: If you are maintaining two versions of OpenEdge on the same machine, 
answer N to this question.

The OpenEdge installation displays status messages while it is decompressing and 
tailoring files. You will also see a WebSpeed configuration message if you are installing 
any products with WebSpeed components. For more information, see OpenEdge Getting 
Started: Installation and Configuration.

24. Press RETURN. When the installation is complete, the following dialog box appears:
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25. Choose End the OpenEdge Installation to exit. The UNIX system prompt appears.

26. You can now unmount the CD by entering the following command:

Uninstalling OpenEdge Replication

OpenEdge Replication provides a utility to properly uninstall the product.

To uninstall OpenEdge Replication:

1. Enter the following command from your OpenEdge Replication /bin directory:

The following warning appears:

2. Choose y to unglue OpenEdge Replication.

Unglue removes all OpenEdge Replication-specific files from the OpenEdge directory, 
but it does not remove the OpenEdge Replication product itself. 

3. To remove the OpenEdge Replication product, you must delete the OpenEdge Replication 
directory tree. 

umount device-name mount-point

./repl_unglue
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